ASCET V6.2
Installation Guide
Copyright

The data in this document may not be altered or amended without special notification from ETAS GmbH. ETAS GmbH undertakes no further obligation in relation to this document. The software described in it can only be used if the customer is in possession of a general license agreement or single license. Using and copying is only allowed in concurrence with the specifications stipulated in the contract.

Under no circumstances may any part of this document be copied, reproduced, transmitted, stored in a retrieval system or translated into another language without the express written permission of ETAS GmbH.

© Copyright 2013 ETAS GmbH, Stuttgart

The names and designations used in this document are trademarks or brands belonging to the respective owners.

Document EC019906 V6.2 R01 EN - 05.2013
## Contents

**1 General Information**  .................................................. 5  
1.1 Safety Advice  ............................................................. 5  
1.1.1 Correct Use  ......................................................... 5  
1.1.2 Labeling of Safety Instructions  ................................. 5  
1.1.3 Demands on the Technical State of the Product  ............ 5  
1.2 About this Manual  ..................................................... 6  
1.3 Documentation Conventions  ......................................... 6  
1.4 Typographic Conventions  ............................................. 7  

**2 Program Installation** .................................................. 9  
2.1 Preparation  ............................................................... 9  
2.1.1 Contents  .............................................................. 9  
2.1.2 System Requirements  ............................................. 10  
2.1.3 Required User Privileges for Installation and Operation . 10  
2.2 Installation from Installation Disk  ............................... 11  
2.2.1 Initial Installation - ASCET Base System .................. 12  
2.2.2 Installation - ASCET-MD and Other ASCET Products ....... 17  
2.2.3 Special Installation Steps and Dialogs  ...................... 18  
2.2.4 Command Line Installation  ..................................... 21  
2.3 Network Installation  .................................................. 22  
2.3.1 Installing ASCET Products from a Network Drive .......... 23  
2.3.2 Customizing the Network Installation ....................... 23  
2.4 ASCET Directories  ................................................... 30  
2.4.1 Default Storage Directories  .................................. 30  
2.4.2 Changing Default Directories  ................................ 31  
2.5 Uninstalling ASCET  ................................................ 31  
2.5.1 Automatic Uninstall  ............................................. 32  
2.5.2 Custom Uninstall  ................................................ 34
## Contents

3 Licensing the Software ......................................................... 37
   3.1 ETAS License Models .................................................. 37
   3.2 How to Get a License .................................................. 37
   3.3 The License File ...................................................... 38
   3.4 Grace Mode .............................................................. 40
   3.5 The "Expiration Warning" Window .................................... 40
   3.6 Borrowing a License ................................................... 41

4 ETAS Contact Addresses ..................................................... 45

Index ..................................................................................... 47
1 General Information

The ASCET product family provides an innovative solution for the functional and software development of modern embedded software systems. ASCET products support every step of the development process with a new approach to modeling, code generation and simulation, thus making higher quality, shorter innovation cycles and cost reductions a reality.

This manual describes the installation of ASCET products. The products themselves are described in the products' manuals or online help files.

1.1 Safety Advice

Please adhere to the Product Liability Disclaimer (ETAS Safety Advice) and to the following safety instructions to avoid injury to yourself and others as well as damage to the device.

1.1.1 Correct Use

ETAS GmbH cannot be made liable for damage which is caused by incorrect use and not adhering to the safety instructions.

1.1.2 Labeling of Safety Instructions

The safety instructions contained in this manual are shown with the standard danger symbol shown below:

*WARNING*

Indicates a possible medium-risk danger which could lead to serious or even fatal injuries if not avoided.

*CAUTION*

Indicates a low-risk danger which could result in minor or less serious injury or damage if not avoided.

*NOTICE*

Indicates behavior which could result in damage to property.

1.1.3 Demands on the Technical State of the Product

The following special requirements are made to ensure safe operation:

- Take all information on environmental conditions into consideration before setup and operation (see the documentation of your computer, hardware, etc.).
WARNING!
Wrongly initialized NVRAM variables can lead to unpredictable behavior of a vehicle or a test bench, and thus to safety-critical situations.

ASCET projects that use the NVRAM possibilities of ASCET-RP targets expect a user-defined INIT process that checks whether all NV variables are valid for the current project, both individually and in combination with other NV variables. If this is not the case, all NV variables have to be initialized with their (reasonable) default values.

Due to the NVRAM saving concept, this is absolutely necessary when projects are used in environments where any harm to people and equipment can happen when unsuitable initialization values are used (e.g. in-vehicle-use or at test benches).

Further safety advice is given in the ASCET V6.2 safety manual (ASCET Safety Manual.pdf) available on your installation disk, in the ETASManuals\ASCET V6.2 folder on your computer or in the download center of the ETAS web site.

1.2 About this Manual

The ASCET installation guide contains the following chapters:

- "General Information" (this chapter)
  This chapter provides some basic information regarding this manual.
- "Program Installation"
  This chapter targets both all users who install, maintain or uninstall ASCET on a PC or a network as well as system administrators who provide ASCET on a file server so that the program can be installed via the network. It contains important information on the scope of delivery, hardware and software requirements for stand-alone and network installations and the preparation required for installation. The chapter also describes the procedures used to install and uninstall ASCET.
- "Licensing the Software"
  This chapter contains various licensing information, e.g. how to obtain a license file or how to borrow a license.
- "ETAS Contact Addresses"
  Contact information of the various ETAS subsidiaries.

1.3 Documentation Conventions

All actions to be performed by the user are presented in a a task-oriented format as illustrated in the following example. A task in this manual is a sequence of actions that have to be performed in order to achieve a certain goal. The title of a task description usually introduces the result of the actions, e.g. "To create a new component", or "To rename an element". Task descriptions often contain illustrations of the particular ASCET window or dialog box the task relates to.
To achieve a goal:

Any preliminary information...

- Step 1
  Explanations are given underneath an action.
- Step 2
  Any explanation for Step 2...
- Step 3
  Any explanation for Step 3...

Any concluding remarks...

1.4 Typographic Conventions

The following typographic conventions are used in this booklet:

Select **File** → **Open**. Menu options and buttons are shown in **blue boldface**.

Click **OK**. Keyboard commands are shown in angled brackets and **CAPITALS**.

Press `<ENTER>`. Names of program windows, dialog windows, fields, etc. are shown in quotation marks.

The "Open File" dialog window opens. Text in drop-down lists on the screen, program code, path- and file names are shown in the **Courier** font.

Select the file **setup.exe**. General emphasis and new terms are set in **italics**.

A distribution is always a one-dimensional table of sample points. Links to internet documents are set in **blue, underlined** font.

The OSEK group (see [http://www.osekvdx.org/](http://www.osekvdx.org/)) has developed certain standards.

Important notes for the users are presented as follows:

**Note**

Important note for users.
2 Program Installation

The chapter entitled "Program Installation" targets both all users who install ASCET on a PC or a network, or maintain and uninstall the program as well as system administrators who provide ASCET on a file server so that the program can be installed via the network. It contains important information on the scope of delivery, hardware and software requirements for stand-alone and network installations and the preparation required for installation. The chapter also describes the procedures used to install and uninstall ASCET.

2.1 Preparation

Check the items supplied for completeness and your computer for compliance with the system requirements. Depending on the operating system used and the network connection, you have to make sure that you have the user privileges required.

2.1.1 Contents

ASCET is supplied with the following:

- ASCET installation disk
  - ASCET program files
  - ASCET manuals and ETAS hardware documentation in PDF format (Acrobat Reader)
  - Manual "FLEXnet Licensing End User Guide" in PDF format

Furthermore, you require a valid license for the use of ASCET products. You can obtain the license files required for licensing either from your system administrator or through a self service portal on the ETAS Internet Site; the URL is given in the entitlement letter. To request the license file you have to enter the activation number which you received from ETAS during the ordering process. See also chapter 3 "Licensing the Software" on page 37.
2.1.2 System Requirements

The following system requirements have to be met:

<table>
<thead>
<tr>
<th>Minimum Required</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operating System</strong></td>
<td></td>
</tr>
<tr>
<td>• Windows® 7 (x86 or x64)</td>
<td>• Windows® 7 (x64)</td>
</tr>
<tr>
<td>• Windows® Vista (x86) + SP1</td>
<td></td>
</tr>
<tr>
<td><strong>Hardware</strong></td>
<td></td>
</tr>
<tr>
<td>• 1.5 GHz Pentium PC</td>
<td>• 2 GHz dual-core o. equivalent</td>
</tr>
<tr>
<td>• 1 GB RAM</td>
<td>• 4 GB RAM</td>
</tr>
<tr>
<td>• DVD ROM drive</td>
<td>• DVD ROM drive</td>
</tr>
<tr>
<td>• network adapter</td>
<td>• network adapter</td>
</tr>
<tr>
<td>• Graphics with resolution of at least 1024 x 768, 32 MB, 16 bit color, DirectX 7</td>
<td>• 2nd network adapter if using ASCET-RP</td>
</tr>
<tr>
<td></td>
<td>• Graphics with a resolution of 1600 x 1200, 128 MB RAM, 32 bit color, DirectX 7 or higher, hardware acceleration</td>
</tr>
<tr>
<td><strong>Free disk space</strong></td>
<td></td>
</tr>
<tr>
<td>• 3 GB (not including space for program data)</td>
<td>• &gt; 4 GB (not including space for program data)</td>
</tr>
</tbody>
</table>

Note

You need administrator rights to perform the settings described below.

2.1.3 Required User Privileges for Installation and Operation

**User privileges required for installation:**

In order to install ASCET on a PC, you need the user privileges of an administrator. Please contact your system administrator, if necessary.

**User privileges required for operation:**

In order to operate ASCET, each user must receive the privilege called "Increase Scheduling Priority" from the administrator. This can be set using the User Manager.

**Recommendation:** Assign the privilege "Increase Scheduling Priority" to the local "User" group. To do so, proceed as follows:

**To assign the User Privilege "Increase Scheduling Priority":**

- **Windows Vista:**
  - From the Start Menu, select **Control Panel → System and Maintenance → Administrative Tools → Local Security Policy**.

- **Windows 7:**
  - From the Start Menu, select **Control Panel → Administrative Tools → Local Security Policy**.
• Under **Local Policies → User Rights Assignment** activate **Increase Scheduling Priority** by double-clicking on it.
   The "Increase scheduling priority Properties" window is displayed.
• Click on the **Add User or Group** button.
   The "Select Users, Computers or Groups" window is displayed.
• Click on the **Locations** button.
   The "Locations" window is displayed.
• Select the local workstation and close the "Locations" window by clicking **OK**.
   The "Select Users, Computers or Groups" window is renamed to "Select Users or Groups".
• In the "Select Users or Groups" window, click on the **Advanced** button to enable the automatic search feature.
   Another window named "Select Users or Groups" opens.
• Click on the **Find now** button to display the list of users registered for the local workstation.
• In the "Name (RDN)" column, choose the names of the users or groups to whom you want to assign the privilege to increase the scheduling priority.
• Confirm by clicking the **OK** button.
• Close the first "Select Users or Groups" window by clicking **OK**.
• Close the "Increase scheduling priority Properties" window by clicking **OK**.
• Exit the local security policy settings.

### 2.2 Installation from Installation Disk

To install one of the add-on products (e.g., ASCET-MD, ASCET-RP, ASCET-SE, ASCET-SCM), you have to install the ASCET base system first. ASCET-SCM requires, in addition, the installation of either ASCET-MD, ASCET-RP or ASCET-SE.

Installation is performed in the same way if you install ASCET from the CD or the network drive. During installation, log files are written, which can later be used to verify the installation (see the ASCET online help for details).

Chapter 2.2.1 describes the installation of the base system in detail. The installation of add-on products is briefly described in chapter 2.2.2; if additional information is required, see the respective manuals or release notes.

Special issues to be observed during the installation (e.g., "To cancel the installation:" or "To overwrite an existing program version:" ) are described in chapter 2.2.3. Chapter 2.2.4 contains information on command-line installation.
2.2.1 Initial Installation – ASCET Base System

To start the ASCET installation:

**Note**
You can install ASCET only on a supported operating system (see section 2.1.2 for a list). If you try to install ASCET on an unsupported operating system, an error message opens and the installation aborts.

- Insert the installation disk into the respective drive of your computer.
- If the installation does not start automatically, double-click on `start.exe`. An installation dialog opens.
- Click on the Main link to go to the installation page.

**Note**
You must install the ASCET base system before you can install ASCET-MD or any other ASCET product except ASCET-DIFF.

License Agreement:

- In the "EULA" window, activate the **Accept** option to accept the license agreement.
• Click **OK**.
• Follow the instructions displayed on the screen. The **Next** button accepts your settings and proceeds to the next window, the **Back** button returns to the previous window, and **Cancel** aborts the installation.

**To register ASCET:**

• In the registration window, enter your personal information.

![Registration information window](image)

• Click on the **Next** button.
To specify ASCET paths:
When you have registered ASCET, you are prompted to specify target directories for program files and data.

Program files and program data are stored in different directories. When you uninstall or update the program later, only the program files will be deleted or overwritten. The program data will continue to be available to you. The program data includes the following:

- Databases
- User profiles

**Note**
You can install ASCET in a directory with blanks in its path. Before you do so, however, make sure that all external tools used with ASCET support path names with blanks, too.

When you are installing ASCET on Windows 7, make sure that you select an installation directory that offers write access during ASCET operation; ASCET writes to files in the installation directory. It is recommended that you do not use the `Program Files` directory as installation directory.

- If you want to change the default directories, click on the **Browse** button.
- In the path selection dialog window, select the desired directory.
  If you specify a directory which does not exist, the installation routine will automatically create it.
- Click on the **Next** button.
To specify the ASCET folder in the Start menu:

- Accept the default folder name
- or
- specify a different folder name.
- Click on the Next button.

Installing ASCET:

The "Ready to install" window lists the directories for log files and temporary files. You cannot change these paths.

**Note**

With the next step, you start the installation.

- In the "Ready to install" window, click Next to start the installation.
  The program files will be copied. A bar chart indicates the copy progress.

If necessary, the ETAS license manager is installed with the program.

Finally the "Installation complete" window appears.
- In the "Installation complete" window, click on the Finish button to finish the installation.

After the installation is complete, you will find the folder name you specified with the following entries in the Start menu:

- **ASCET Help**
  Opens the ASCET online help.

- **ASCET Uninstall**
  Starts the uninstall routine (see chapter 2.5).
• **ASCET V6.2**
  Starts the ASCET program.

• **AS Editor**
  Starts the AS Editor (see ASCET online help for more information).

• **Online manuals**
  If you installed the online manuals, you can here open the `ETAS\ETASManuals` directory. Here, the manuals are stored in several subdirectories.

• **ReadMe**
  Provides current information on ASCET V6.2.

The ETAS License Manager has a separate folder **License Management** in the ETAS program group of the Start menu. This folder contains a single entry, **ETAS License Manager**.

Several sample files are located in the `export` directory of your ASCET installation; they are available as `.exp` or `.axl` files. They can be imported in any ASCET database (both formats) or workspace (`*.axl` only).

• **ETAS_System_Library.*`** and **ETAS_System_CT_Library.*`** - ETAS system libraries (containing various basic modelling blocks such as the PT1 element or other basic filter elements, integrators, etc.)

• **ETAS_MBFS_Library.*`** - ETAS system library containing a subset of the blocks defined by the ASAM AE M BFS standard

• **Tutorial.*`** - ETAS tutorial

• **Tutorial AUTOSAR UG.*`** - AUTOSAR tutorial

**Note**

ASCET cannot be started until ASCET-MD, ASCET-RP, or ASCET-SE is installed, too.

---

1. available at [http://www.asam.net](http://www.asam.net)
2.2.2 Installation – ASCET-MD and Other ASCET Products

After installing the basic system, you can install ASCET-MD or other ASCET add-on products.

**To install ASCET add-ons:**

**Note**
You can install only ASCET add-ons that match an ASCET version already present on your computer. If you try to install an ASCET add-on onto a non-matching ASCET version, an error message opens and the installation aborts.

- Re-open the installation dialog.

**Note**
You can install only ASCET add-ons that match an ASCET version already present on your computer. If you try to install an ASCET add-on onto a non-matching ASCET version, an error message opens and the installation aborts.

- Click on the ASCET-MD link (or the link of another ASCET product you want to install).

**Note**
You must install the ASCET base system before you can install ASCET-MD or any other ASCET product except ASCET-DIFF. ASCET-SCM can only be used if ASCET-MD, ASCET-SE or ASCET-RP is installed, too.

- Follow the instructions on the installation dialogs. The selected product is installed.

ASCET-RP adds the **ETAS Network settings** entry to the ETAS program group of the Start menu. This entry starts the assistant for the configuration of the ETAS network.
2.2.3 Special Installation Steps and Dialogs

To cancel the installation:

Before you click **Next** in the "Ready for installation" window, you can still cancel the installation prematurely. Proceed as follows:

- Click the **Cancel** button in the current window.

- Click **Resume** to return to the previous dialog box.

- Click the **Exit Setup** button to quit the setup program.

- Confirm that you want to cancel the installation by clicking **OK**.
To overwrite an existing program version:
If an older version of the software to be installed is found on the target workstation, or if an entirely different software exists in the selected installation directory, a corresponding dialog box appears. The following sample dialog box would appear during ASCET installation if an older version would have already been installed on the target workstation.

- Read the instructions carefully.  
  You are informed that an older installation has been found, and that files will be overwritten when you continue.
- To select a different directory, click the Back button.
- If you want to overwrite the existing files, click the Yes, overwrite it button.

- Acknowledge the confirmation prompt by clicking Yes, overwrite it!  
  Click No to return to the previous window.
To overwrite existing directories:

If the directories specified during the installation already exist, and a complete ASCET installation does not exist on the target workstation, the following dialog window appears. This case occurs, e.g., if a previous installation process has been canceled.

- Read the instructions carefully. You are informed that the directory you selected already exists.
- To select a different directory, click the Back button.
- If you want to overwrite the existing directories, click the Yes, overwrite it button.

- Acknowledge the confirmation prompt by clicking Yes, delete all!
  ASCET is installed; existing files are deleted.
  Click No to return to the previous window.
Installation on an unsupported OS:
This message box appears if you try to install ASCET on an unsupported operating system.

- Confirm by clicking OK.
  This installation is terminated.
- Restart the installation after you have received a supported operating system.

Installation without administrator privileges:
Administrator privileges are prerequisites for the installation of ASCET. The following message box appears if the user name under which you logged on to Windows has no administrator privileges.

- Confirm by clicking OK.
  This installation is terminated.
- Please contact your system administrator.
- Try the installation again after you have received the required privileges.

2.2.4 Command Line Installation
When you start the installation from a command line, you can use several command line arguments to customize the installation.

`/?` or `/h`
Opens a window with the valid command line arguments.

`/silent` or `/s`

**Note**

/silent must be the first command line argument. If other arguments precede it, /silent has no effect.

Silent installation mode. With this installation mode, no dialog windows requiring user information open. Default values, or values from the `install.ini` file, are used for all information normally requested in installation windows. Error messages are hidden, too.
Program Installation

Silent installation is started as hidden process. An icon appears in the system tray during installation, but you cannot access the process.

A log file silent.log is created in the ASCET installation directory. It uses the *.ini file format with a section for each ASCET product installed in silent mode. As long as the installation is running, the respective section contains a line

```
install=in progress
```

After a successful installation, that line is changed to

```
install=successfully finished
```

If a reboot is required after installation, the reboot is performed automatically, unless you prevent it by an entry\(^1\) in install.ini. The following line is added to the respective section in any case:

```
need reboot=yes
```

/\basic

Basic installation mode. In this installation mode, no dialog windows requiring user information open, except the EULA window. The basic installation mode works as the silent installation mode, except that animations, the progress bar and error messages are shown and no log file similar to silent.log is created.

\textbf{Note}

For some ASCET products, environment variables can be defined, or preferences must be set in the install.ini file to control silent or basic installation. See the respective documentation for details.

/\ini="<MyPath>\<IniFileName>.ini"

By default, the install.ini file in the installation file directory is used for installation. It may be reasonable, however, to use different installation *.ini files for different installations, e.g. if several customers install ASCET products from one central share.

If an installation *.ini file is located outside the installation file directory, it is accessed via /\ini="<MyPath>\<IniFileName>.ini".

If an installation *.ini file is located inside the installation file directory, it is accessed via /\ini=".\<IniFileName>.ini".

2.3 Network Installation

In addition to the installation from the disk, you can also install ASCET from a network drive on the PC.

The network installation provides the benefit that you can adjust data even before the actual installation on the workstation takes place (see section 2.3.2).

\footnote{1: [SilentInstallation]
;prevents a silent installation from rebooting when
;set to "Suppress"
Restart=Suppres}
2.3.1 Installing ASCET Products from a Network Drive

The sequence of dialogs when installing from a network drive is the same as when installing from an installation disk (see "Installation from Installation Disk" on page 11).

**To provide data on the network server:**

To provide data in the network, you have to copy the installation files from the installation disk to the desired network drive.

- Create a source directory on the desired network drive.
- Copy all data from the installation disk to the source directory.
- If desired, customize the installation; see also section 2.3.2

**To start the installation:**

- Search for the *.exe file (i.e. ASCET.exe, ASCET-MD.exe, etc.) of the product you want to install.
- Double-click the file.
- Follow the instructions in the installation dialogs.

2.3.2 Customizing the Network Installation

You can customize ASCET (modifying specific default settings) even before the user installs ASCET on his workstation.

You have the following customizing options for the network installation:

- You can customize the installation dialogs, e.g., modify the default settings for directories, etc. (see "Customizing Installation Dialogs" on page 24).
- When one installation is finished, you can perform up to 50 additional installations (see "Concatenating Installations" on page 24).
- You can specify the storage location for the network installation log file (see "Logging the Installation Information" on page 25).
- You can define the way in which ASCET accesses the required licenses (see "Setting the Licensing Behavior" on page 26).
- You can perform the ASCET installation fully automatically and without user intervention invisibly in the background (see "Automatic Installation" on page 28).
- You can overwrite the files provided in the product data directory (default setting: [drive]:\ETASdata\ASCET6.2\...) with your customized files and/or add files to the existing directories (see "Customizing ASCET Files" on page 28).
Customizing Installation Dialogs

For the network installation in large enterprises, it is often necessary to customize certain default settings during the installation to fit internal standards and requirements. This is possible by means of the install.ini configuration file. This file is located in the installation directory.

The following example will show you how to modify the default settings.

To customize the configuration file:

- Open the install.ini file with a text editor. The following is a typical example of an entry in this INI file:
  
  ;Sets the main directory of ASCET
  ;MainDir=c:\etas\ASCET6.2

- To modify the default setting, delete ";" (comment) on the line with the MainDir keyword.

- Change the path to, e.g., H:\programs\etas\ASCET6.2.
  
  The entry should now look like this:
  
  ;Sets the main directory of ASCET
  MainDir=H:\programs\etas\ASCET6.2

- In the same way, modify all other entries in install.ini as desired.

- Save your changes and then close the editor.

When you now start the installation with Ascet.exe, the dialog boxes will show the new settings as defaults.

Note

The modified path settings affect the functions described below.

Concatenating Installations

Using the AutoInstallXX parameter in install.ini, it is possible to access up to 50 additional installations after finishing one installation.

To concatenate installations:

- Open the install.ini file with a text editor. The following entries pertain to concatenating installations:
  
  ;AutoInstall01=..\Installation2\Install.EXE
  ;AutoInstall02=

- To enable this function, delete the ";" (Comment) that is on the same line as the keyword AutoInstall01.
• Change the path to, e.g.,
  ..\..\HTMLInstall\setup.exe.
  Be sure to enter a specific path that is different from
  the ASCET installation file. Here, ".." means one
directory level upward.

AutoInstall01=..\..\HTMLInstall\setup.exe

Repeat these steps, if necessary, for additional
installation files (max. AutoInstall10).

Logging the Installation Information

When installing from a network drive, the information entered in the registration
dialog is saved in a file (ASCET\[_*].usr). It is used for your own reference
only. By default, the file is stored on the source drive from which the installation
was started, under a dedicated directory named User (e.g., <source
drive>:\User\ASCET.usr).

As already mentioned during the registration for network installation, you can
change the storage location specified in install.ini. You can also disable
the log function.

To specify the logging of registration information:

1. Open the install.ini file with a text editor.
2. Go to the [Network-Preferences] section.
3. Use the NetUserLogging option to enable
   (true) or disable (false) the logging of registration information.
   NetUserLogging=true
   or
   NetUserLogging=false
4. Use the following entry to specify the logging directory:
   ;NetUserLogPath=i:\User
5. To modify the default setting, delete ";" (Com-
   ment) on the line with the NetUserLogPath key-
   word and change the path to, e.g., x:\UserLog.
   NetUserLogPath=x:\UserLog
6. Edit the NetUserLogPrefix and
   NetUserLogSuffix options to specify a prefix or
   suffix to the log file name.
7. Save your changes.

Note

Make sure that all users have write-access to the log directory, i.e., the source
directory or the directory you specified in install.ini (see below).
If the installation files are on a local hard disk, the installation process is not logged by default. If you also want to log the installation process for local installation, delete the comment character as described above and specify the desired path.

Setting the Licensing Behavior

In the [Licensing] section of install.ini, you can define the way in which ASCET and other ETAS software programs access the required licenses.

To define the access to the required licenses:

- Open the install.ini file with a text editor.
- Go to the [Licensing] section and modify the settings as desired.
  The parameters that can be included in this section, and their settings are described below.
- Save your changes.

The following parameters may be used:

- LicenseFileName
  Defines the absolute path to the location of the license file which is to be added.

- LicensesToBorrow
  You can use this setting if licenses can be borrowed from a license server. To enable the borrow mechanism, you must enter the name of the product or features license (e.g. ASCET). If you enter more than one license, the license names must be separated by blanks.

The ASCET product family uses the following licenses:

<table>
<thead>
<tr>
<th>License name</th>
<th>Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCET-MD</td>
<td>ASCET Modeling and Design</td>
</tr>
<tr>
<td>ASCET-RP</td>
<td>ASCET Rapid Prototyping</td>
</tr>
<tr>
<td>ASCET-SE</td>
<td>ASCET Software Engineering</td>
</tr>
<tr>
<td>ASCET-DIFF</td>
<td>ASCET Difference Viewer</td>
</tr>
<tr>
<td>ASCET-SCM</td>
<td>ASCET Software Configuration Management</td>
</tr>
</tbody>
</table>

- BorrowExpiryMode
  Defines the way in which the expiration of the borrow status is given. Possible values are:
  - Date
    If the BorrowExpiryMode is set to Date, the borrow period will expire at a certain date which is specified under BorrowExpiryDate.
  - Interval
    If the BorrowExpiryMode is set to Interval, the borrow period will expire after a certain number of days which is specified under BorrowExpiryInterval.
• **BorrowExpiryDate**
  If the **BorrowExpiryMode** is set to **Date**, this parameter specifies the date when the borrow period expires. The format is `yyyy-mm-dd`.

• **BorrowExpiryInterval**
  If the **BorrowExpiryMode** is set to **Interval**, this parameter specifies the length of the borrow period in days.

• **ExecuteBorrowAutomaticExtensionInterval**
  Defines at what point of time the borrow period will be automatically extended. This parameter specifies the number of days before the expiration of the current borrow period. When this time is reached, the borrow period is automatically extended to the interval specified under **BorrowAutomaticExtensionInterval**.

• **BorrowAutomaticExtensionInterval**
  This parameter specifies the borrow interval in days that is applied when an automatic extension of the borrow period is executed (as defined under **ExecuteBorrowAutomaticExtensionInterval**).

• **ImmediateBorrow**
  You can define that a license is automatically borrowed. Possible values are:
  - **True**
    The license is borrowed automatically at installation time.
  - **False**
    The license will be borrowed at the first time when the program connects to the license server.

• **CustomLicenseFolder**
  Due to the fact that the default location for added license files (e.g., `C:\Documents and Settings\All Users\Application Data\ETAS\FlexNet` for Windows XP) is only writeable for users with admin rights, a different path for the license file folder may be specified with this parameter.

The following example defines that borrowing is enabled for ASCET. The license will be borrowed when ASCET will be started for the first time; by default the license expires after 100 days.

```
[Licensing]
LicenseFileName = 'd:\licenses\MyLicense.lic'
LicensesToBorrow = 'ASCET-MD'
BorrowExpiryMode = 'Interval'
BorrowExpiryInterval = '100'
ImmediateBorrow = 'false'
```
Automatic Installation

By calling `Ascet.exe /s` you can execute the ASCET installation fully automatically and transparently in the background, i.e., without any required user interaction. This will select the currently valid default settings. You can configure these settings in the `install.ini` file (see "Customizing Installation Dialogs" on page 24).

If you as the system administrator create a batch file containing the `ascet.exe /s` command, and configure the required settings in `install.ini`, the users can run the installation process themselves by executing this batch file without the need to enter any further information.

As this type of installation does not display any dialog boxes, you may want to provide some mechanism to inform the user when the installation has finished. See also chapter 2.2.4 "Command Line Installation" on page 21.

Customizing ASCET Files

During installation, the customization feature described below allows you to control the installation routine to the extent that your customized files will overwrite certain default files, or that other files will be included in the installation.

Doing this allows you to integrate your customized databases, user profiles, and window templates in the installation routine.

Create a subdirectory named `InstData\...` in the source directory and copy your customized files into it while maintaining the proper directory structures.

To create your customized files, install ASCET on a test computer, and use this to create the files.

After the default installation of ASCET, the `ETASData\ASCET6.2\...` directory contains various subdirectories with files that determine the ASCET default settings which you can customize. These include the following subdirectories:

- **Database\DB**
  The `DB` subdirectory contains the default database. Here you can, e.g., create another demo database under `Database\DemoDB`.

- **User\[user name]**, depending on the windows login
  The `[user name]` subdirectory contains the default user profile. All configurable options are stored in this subdirectory.

**Customizing Data for Network Installation:**

- Install ASCET on your PC.
- Start ASCET.
- Modify the user profile.
- Modify the database or add a new one.
- Exit ASCET.

You have finished your customization and now want to integrate these files in the installation routine. You have two choices.

- Overwrite existing files that have the same name with your customized files. To be able to do this, you must create a folder named `InstData\overwrite\` in the source directory.
• Rename your customized files and add them to the existing files. With that, there are no files with the same name that could be overwritten. To rename your customized files, you must create a folder named InstData\add-only\ in the source directory.

To include your customized files in the installation routine, be sure to copy also the parent directories. Note that the ETASData\ASCET6.2\ directory level must be the same as InstData\overwrite\ or InstData\add-only\. Examples:

InstData\overwrite\user\userdefaultSettings.xml
InstData\add-only\database\additionalDB\n
**To integrate a modified user profile:**

- Copy your customized file ETASData\ASCET6.2\user\[username]\userSettings.xml into the InstData\overwrite\user\ subdirectory.
- Rename userSettings.xml to userdefaultSettings.xml. This ensures that this initialization file will be used after the installation for each new user.

**To integrate a modified database:**

- Copy your customized database, i.e., the \database\DB\ subdirectory into the InstData\add-only\... subdirectory.
- Rename the db directory as desired, otherwise the database will not be copied.
  
  Of course, you could also overwrite the db database by using the InstData\overwrite\ directory.

When starting the installation routine with ascet.exe, your customized files will replace the default files, and/or your new files will be added in the corresponding directories.
2.4 ASCET Directories

During ASCET installation, the following directory structure is created on the installation disk (unless you modify the path settings):

2.4.1 Default Storage Directories

- **Databases**
  ETASData\ASCET6.2\Database
- **Workspaces**
  ETASData\ASCET6.2\Workspaces
- **Export**
  ETASData\ASCET6.2\Export
- **Import**
  ETASData\ASCET6.2\Export
- **generated code**
  ETAS\ASCET6.2\CGen
- **automatically generated documentation**
  ETASData\ASCET6.2\Docu (created during documentation generation)
2.4.2 Changing Default Directories

You can use the "Options" dialog window to change the default storage directories. To do so, proceed as follows:

**To change the default storage directories:**

- In the Component Manager, select the menu option **Tools → Options**.
  
  The ASCET options window opens. You can change the database, workspace, import, export, and documentation paths in the "Environment\Paths" node, and the code generation path in the "Build\Paths" node.

- Click on the button next to the path you want to change.
  
  The "Path selection" window opens.

  - Specify the directory you want to use as default for the selected option.
  - Click **OK**.
    
    The selected directory is displayed in the "Options" window.
  - Repeat these steps for each option you want to change.
  - When you are ready, click **OK** in the "Options" window to accept the changes, or click **Cancel** to discard the changes.

2.5 Uninstalling ASCET

When ASCET is uninstalled, all matching add-ons on the computer are uninstalled, too. You can uninstall only the entire ASCET product family, not separate products as ASCET-MD, ASCET-SE or ASCET-RP.
There are several ways to start the ASCET uninstall process:

1. Via **Add/Remove Programs** or **Programs and Features** in the Windows Control Panel.
2. Via **Uninstall** from the **ASCET6.2** program group in the Windows start menu.

### 2.5.1 Automatic Uninstall

To uninstall ASCET (automatically):

- **Start the uninstall procedure.**
  - The following window is displayed:

- **Select Automatic.**
- **Click Next.**
Click **Finish** to execute the uninstall process.

You can cancel the uninstall process. If you click the **Cancel** button, the following window appears:

**Note**

If data has already been deleted, ASCET must be reinstalled.
2.5.2 Custom Uninstall

To uninstall ASCET (user-defined):

- Start the uninstall procedure.
  The following window is displayed:

  ![Uninstall window]

- Select Custom.
- Click the Next button.
  The "Select Private Files to Remove" window opens.

  ![Select Private Files window]

- In the "Select Private Files to Remove" window, select the files you want to remove.
- Click the Next button.
- In the "Select Directories to Remove" window, select the directories you want to remove.
- Click the Next button.
• In the "Select INI Files to Remove" window, select the *.ini files you want to remove.
• Click the Next button.
• In the "Select INI Items to Edit" window, select the *.ini entries you want to edit.
• Click the Next button.
• In the "Select Registry Keys to Remove" window, select the registry keys you want to remove.
• Click the Next button.
• In the "Select Registry Trees to Remove" window, select the registry folders you want to remove.
• Click the Next button.
• In the "Select Registry Keys to Edit" window, select the registry keys to be edited.
• Click the Next button.
• In the "Select Sub-Systems to Remove" window, select the sub-systems you want to remove.
• Click the Next button.
• In the "Perform Uninstall" window, click the Finish button.

You can cancel the custom uninstall process, as well as the automatic deinstallation, using the Cancel button.

**Note**

If data has already been deleted, ASCET must be reinstalled.
3 Licensing the Software

To be able to work with an ETAS software product, you require a license. This section contains basic details on this subject.

• "ETAS License Models" on page 37
• "How to Get a License" on page 37
• "The License File" on page 38
• "Grace Mode" on page 40
• "The "Expiration Warning" Window" on page 40
• "Borrowing a License" on page 41

Details concerning the scope of the licenses and other legal aspects can be found in "Terms and Conditions".

3.1 ETAS License Models

Machine-Named License, Local

• A license of this type is managed by the users themselves.
• As it is linked to a particular PC (better: to the MAC address of the Ethernet adapter), it is valid wherever the PC is used.
• When you change your PC, you require a new license.

User-Named License, Server-Based

• The licenses (of a department or company) are managed centrally on a server by a designated person.
• The license is linked to the user name with which the user is registered in the network and is available on every PC in the network.
• If the relevant PC is disconnected from the network, the license can be "borrowed".

Concurrent (or Floating) License, Server-Based

Most of what is true of the user-named license applies to this type of license. The difference is that here several users share a limited number of licenses.

3.2 How to Get a License

If your company has a tool coordinator and server-based license management for ETAS software, contact this person. Otherwise (in the case of a machine-named license) you obtain your license from the ETAS license portal (the URL is shown on your Entitlement Certificate).

There are three ways of logging in on the welcome page:

• Activation ID
  Once you have logged in, a specific activation\(^1\) is visible and can be managed – the activation ID is shown on your Entitlement Certificate.

\(^1\) The activations refer to a specific product, its license conditions, the available number of licenses and other details required for generating a license. Activations are identified uniquely with activation IDs.
• **Entitlement ID**
  All activations of the entitlement\(^1\) are visible and can be managed (e.g. for a company with just one entitlement).

• **E-mail and password**
  All activations of the entitlements assigned to the user account are visible and can be managed (e.g. for a tool coordinator responsible for several entitlements).

If you need help in the portal, click the **Help** link.

What Information is Required?

Information on the hosts must be entered to activate licenses:

- **Machine-named license**
  The MAC address of the Ethernet adapter to which the license is to be bound is required here.

- **User-named license**
  Here, you need a server host or a server triad as well as a user name.

- **Concurrent (floating) license**
  Here, you need a server host or a server triad.

---

**Note**

If this data changes (e.g. due to changes in the hardware or a change of user), the license must be given a "rehost". This procedure is also described in the portal help file.

License File

The result of your activities is the provision of a file `<name>.lic` with which you can license your software in the ETAS License Manager.

### 3.3 The License File

**To check the license status:**

- In the Windows start menu, select **Programs → ETAS → License Management → ETAS License Manager** to open the ETAS License Manager.

  Or

---

\(^1\) An entitlement shows the authorizations you have as a user; it stands for the right to own one or more licenses for a product. It is a kind of account of rights of use for software from which you can take licenses as you need to.
In the Component Manager, select Help → License Info.

Click Continue.
The ETAS License Manager contains an entry for each installed ASCET product. The symbol at the beginning of the entry and the "Status" column entry indicate if a valid license has already been obtained. If available, already installed licenses for other ETAS products will be listed as well.

To add a license file:

Open the ETAS License Manager (cf. page 38) and select File → Add Licensing File. The "Install License" dialog window opens.
• Next to the "Select License File" field click the ... button.

• In the file selection window, select the license file and click Open.

The "Install License" dialog window shows information on the selected license.

![Install License dialog](image)

**Note**

The "Version" column shows the version number of the license, not the version number of the software.

• Confirm with OK.

The license just added is now listed in the ETAS License Manager. A green symbol before the entry shows that the license is valid.

• Close the ETAS License Manager.

### 3.4 Grace Mode

If you have not yet installed a license, you can still operate the software for a limited amount of time - it then runs in what is referred to as grace mode. The window shows you how long you can continue to operate the software in this mode.

![Grace Mode Warning](image)

### 3.5 The "Expiration Warning" Window

If your installed license runs out in the next 30 days, a warning is shown when you open the ETAS software.
The "Expiration Warning" window contains a list of licenses that expire in the next 30 days. The expiration date is shown for each license; in the case of borrowed licenses (see "Borrowing a License" on page 41) it also shows when the borrowing period expires (i.e. the date when borrow mode runs out).

Click Manage Licenses to open the ETAS License Manager and install a valid license file. As soon as you have installed a valid license, you can continue to operate the ETAS software in normal operating mode.

Click Ignore to close the dialog box and start the ETAS software. This is only possible during the grace period; as soon as the grace period has expired, you can only continue to use the ETAS software once you have installed a valid license file.

As soon as the expiration date has been reached, you can continue to use the ETAS software for a further 14 days in what is referred to as limited mode (see "Grace Mode" on page 40). Once this phase is over, the ETAS software can only be used when a new or updated license file has been installed.

### 3.6 Borrowing a License

The borrowing mechanism makes it possible to work offline even when using a server-based license (i.e. without being connected to the license server).

**Note**

You can only borrow a license if a server-based license is being used!

To borrow a license, proceed as follows:

**To borrow a license**

- Make sure that the ETAS software the license of which you want to borrow is not open.
• Select the license you want to borrow in the "License Listing" table of the ETAS License Manager.

![License Listing Table]

• Select License → Borrow license.
  The "Select Borrow end date" dialog box opens.
• Select the date until which you want to borrow the license from the calendar displayed and click OK.

![Select Borrowed Date]

The text in the "Source" column of the ETAS License Manager changes from SERVER to BORROW, and the expiration date of the borrowed license is displayed.
You can now use the relevant ETAS software offline until the expiration date of the borrowed license has been reached.

If you want to use the ETAS software longer than you had originally planned, you can borrow the license again. If you stop using the ETAS software earlier than planned, you can return the license to the license server early (License → Return License Early). A borrowed license can only be returned by the person that borrowed it; it cannot be returned by another person.
4 **ETAS Contact Addresses**

**ETAS HQ**

**ETAS GmbH**

<table>
<thead>
<tr>
<th>Borsigstraße 14 Stuttgart</th>
<th>Phone:</th>
<th>+49 711 89661-0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>Fax:</td>
<td>+49 711 89661-106</td>
</tr>
<tr>
<td></td>
<td>WWW:</td>
<td><a href="http://www.etas.com">www.etas.com</a></td>
</tr>
</tbody>
</table>

**ETAS Subsidiaries and Technical Support**

For details of your local sales office as well as your local technical support team and product hotlines, take a look at the ETAS website:

- **ETAS subsidiaries** WWW: [www.etas.com/en/contact.php](http://www.etas.com/en/contact.php)
Index

A
ASCET
borrow license 41
install add-on 17
install basic system 12
install license file 39
license file 38
path specifications 14
sample files 16
uninstall 32, 34

B
Basic installation 22
borrow license 41

C
command line 21
basic installation 22
silent installation 21
user-defined *.ini file 22

D
default directories 31

E
text
editor
element 47
element editor
open 47
ETAS Contact Addresses 45

ETAS License Manager
open 38
ETAS license models 37

G
Grace mode 40

I
install license file 39
Installation
assign user privilege (Win Vista) 10
assign user privilege (Windows 7) 10
basic 22
cancel 18
command line 21
customize configuration file 24
customize data for network ~ 28
install add-on 17
install license file 39
integrate modified database 29
integrate modified user profile 29
network installation 22
overwrite existing version 19
path specifications 14
set licensing behavior 26
silent 21
start ASCET installation 12
system requirements 10
uninstall ASCET 32, 34
Installation
  unsupported OS 21
  user-defined *.ini file 22
  without administrator privilege 21

L
License
  borrowing 41
  expiration warning 40
  grace mode 40
  install license file 39
  license file 38
  license models 37
Licensing 37
  grace mode 40
  set behavior 26
  status 38, 39

N
Network installation 22–29

P
Product liability disclaimer 5

S
Safety Instructions
  technical state 5
  sample files 16
  Silent installation 21